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M 1E Director f&41

1.1 BRI

Director &K HI1E L BHARIN K. T LAFES- 2] Director Z i, BANHLIRT #
BEZ S IEEE S A

LIRGAR—ANFOES, ERBE/N\FERTPERHRT . TURXAR, SRR
. Y. BB SE LR MBI e O A . ZABORMEE T AR R . T
HRBMGHER, NAHZREKE 2. SRASRTMZNHATHRSE. 5l &5
ﬁ%%m%ﬁﬁo$¢ﬁﬁ$WM?,@ﬁﬂ%wtﬁ%-@%ﬁﬁ—Tﬁﬁfﬁwﬁﬁ
M Ak, WA ERBREELENHA:

> ABAHT LA AL, SR %5 e B S BRAE BT 7E b 2o 3 M B B 1

> MR, iR —F R IR T (A 1 E —F . HFAAMER X
H .

> —BEETMRERECEIM, ST LRI T MBI R,

> —BAE, N TN SRR R

ZIMARBEIAR, OAFERZILAF RANERZE S, WEMN D HABARBOKREE E
WEA A LS, Rl AR TI TR, B AT Ll RUbR . SR ERAAGS B
PNITE KR GRRL S EE RS

FFR L AR, HEER-NESHCHZRMAA A LR . Director BUE T IHEMR
KL WARFF R TR, R Director, AT LU {5 A Hl 1F H 5675 22 00 2 R4 .

1.2 Director B & R i3%2

Ak TALARHES £ BAGIE T B ¥ Macromedia Director 43 E Macromedia 22 ]
RE H TR R G A R 7.02 (RRA. Director7.02 ] LA & A G il 5E T Mk i) 2 4R
KRR S EEEETLAUH T Macintosh #4F 48, thATLIH T Windows #fER%E. JFAH
KM= M LUET T2 PEHE T, SEAMNERR. AP EEH A7 Windows #1F
AP HIEH .

Director 1% REFIIEA ZEAE AR R R FIH I, Director A RE—HWIE F ot
) 2 AR, *mﬁﬁﬁTuﬁﬁm$ﬁWﬁ*%ﬁﬁﬁ

Director %25 T 1985 4, 4B {4 FRIE L E AT S Video Works, E7E3ER Macintosh
HUi EIEATHY .

7 1989 4EIXFIH {445 i X éw % J Director 1.0, 1991 SER A T 2.0 MIRA, FEIX—RA
th#s Director BN T P KA HINLIE], #REHRSEIAZ BT RER] Lingo 5 Al XObject
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AhE B EIEHEITB. FE, XRMT 3.0 MIRRA, HnT £4 Lingo 4. 1992 F4#E
HT 3.1 BRRAS, R4 T XF QuickTime 7 MBI S 55, 0l LA 3 L 3 2 R0 i 4 b 1

1994 4, Directord.0 HILR—IRFE KM R, CEMW T HIEMET G IME, HEkH
JEZ47 T Macintosh 92 844> ihth al LA#E Windows ], 3 H o] LASER7E XM F 18]
ML WA, FHLAT )T vH1Y Windows JT1/ A2 3 50k RAT W RHL P A ik 22 5
FIRFF R 2 A 5. 1995 4F, Macromedia 23 &) ¥ HEH T T Director 1 Shockwave $
A, XFpH AR T Director FUEEAE Internet AT F], X H4li#} Internet H /' 5252 %)
THIEMZ A5,

{EfG KA Director5.0 H3¥8 N T4 BEIL Xtras, JXFEH] ) 0l LAE T Macromedia [ 18045
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1997 %, Director KB T 6.0 MAA, XBRE B MRA, © 400 L
Internet PASZEIVES R LB T £ 5 KEN T4, i Hol LA 1] Behavior F#/5° b
LA T EMEZAINEE, T8 T HE &I,

TEHEH T Director7.0 F1 Director7.01 FRIRRAZ )5, D XHEH T 7.02 BIF-ZhRA, W
E 1-1 Fis.

B 1-1  Director )T it i

1.3 Director §¢ /3 4L+ 4

Director & —MDIRER A MK £ BT & TR, Hrhpshggar LU —A st gl sk
YELLER. 5B RFIFHILH ) Behavior FEFFBIBUAI Lingo &35, M IRA S SCILAS H IhfiE,
Wit S #) Shockwave Bk, Bl AT LUK AT ShE . A E5H Dircotor HuBSH ik BT
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S — A ] B S A R

B A4 —F Director HIfE L AR it KBUT R, Director [IFEAHIfFLAR ST H
WA EIVE R, B ROk R T e b Stage(PER): KBTI TEEAMES,
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X BT ISR, 2B R Director HIFE % B b RIBIE AR BRI E R
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Tl Behavior FaFFRIELAI B, XA (g RLan N B Rk D, OIS I 2 A
e B R 6 — RN ]k 5] Director, AR PRBLAE M — AR A A OK

1.4 Director7.02 R %E 1012

Fili/r48— T Director7.02 ()23l #4

BT 2% Director7.0 B% Director7.01, SRETEEANIIIEERE ERATHRBAHITHEK .
Fifi b Director /%223 7.0 I B, 433t ity LA L2 2eemi i .

Wit 23 Director7.0 (¥ setup.exe LIS, #4547 FF Welcome To Director X ifHE, ¥
1-2 iR

[E 12 Welcome To Director % i {E

T A 4R EHE b T A T

1. First/Initial/Last Name

X BRGNS .

2. Organization

i L B SR N S BT A A B

3. Serial Number

iX FL B R A\ Director7.0 H7EMHE .

EMINT A2, Al OK $54LEK AT LAFTFF Select Install Options XHEHE, W
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1-3 ffim.

DIRECTOR

P 1-3  Select Install Options i i7HE

XA AP FE:

1. Install Now-Typical set of components-69MB

IXAN T H PR A S 2o . I HIX T, A ARk4 %3 Director7.0 [FT 411,
B (A 4 (] S 65M.

2. Custom-Select components-[17 to 65MB]

XA IEDUEF M RG LR, WREPIX— I, B4 B kR & ey, ol
DA DT R R 17M, BT AN ] e e 238 040 4. 142 Director7.0 Jif
i 2 ] S AL A 17 B 65MB 22 i) .

W RIEA B3 Director7.0 1 7 MR ek # S 2= 10) L 45K, sk 55— Al 203 /2.

RTINS EHE ) Next #4241, 0] LL4TH Choose Destination Location &4, 1[4
1-4 iR,

¥ 1-4 Choose Destination Location % iG#HE
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WUR R AARZE R A (9 H 3% C:\Program Files\Macromedia\Director7 T XA A, T
L fiif Browse $&41, (EBG BRI HHES B CIEFE H K-
SR it Next 126ll, #4247 FF Select Program Folder XHi&4E, & 1-5 ffizs.

FLL

RickiwinG7 for Windows
SHOCK TROOPERS 2

i

g 1-5 Select Program Folder X %
XA X T A J ) ok ik 46 37 2245 19 Diirector £EFFUASE A IO B, FF mi X HE ) Next
f5dll, MAZYMITER T, Wi 1-6 Fis.

P 16 Zedbeimii

FIX I Rl i 4 2edesE T Director7.0-
T i E4E Director7.0 F-2l % Director7.02.
ST A dTupd702.exe i, JERCE M 236 H R BLEFE Director7.0 FTERI H %,
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BT HRN AR RS, BRI %3¢ T Director7.02.

1.5 Director7.02 BY#18Ih &k

Director7.02 A%} Director7.0 i H-8A7T K KMSGHE. WA T 6.5 WAL —A
/N GEE

L5 6.5 HIAAHEL, Director7.02 =#E47 LL R ik

> Director7.02 7 T KEE, A s A S AN, i HARBCER, 5
ftiH .

> ST 999 WURP ARG RE, IR LIS T A SR

> RRIACES 1 eh RS R B EOM N E] 1000 A, T EARIE G S dLEE .

> A LLZERI A b oG8R & rh dORE R R e FIAS TR AR . T LLATSE A 2 N80 53 k5K
BlIX SR

» X3 Alpha MLEAY 32 PrAOMPE, ASTE BERFER ABURE A TR AT LA A Tk ) 17 1
BOR, TP A TR RBOR

> aJLLilid RGB k& AFite, o LAaT S Akl alSie el AP g kA, X
{75 B0 £, (0 2 3 O S v

> RBERATE 8 MLARBERIE SVt gE —BIbRUER S (AR b, SR AT LU v Ya 28
cha] fl BB R, R R

> AJLLA 256 (A pvE 5 Bk E DR A Eh A bR, 9T HLEOT RUBR I R SR ) i i)
HRE, K/NAAR 3232, T LART H Akl HERAR 16 X 16 B R EH RAR.

> ATRLINA HTML #3324, Director £ fig i 51 31 4h 46 2 ik A bric.

> SCAPr S AR AN, i BAT CAZERR SO S, 10 DA S B R A W] BA L
FhSO gt . BLAE SCAR Y K/ B2 R GE TR IR ) PR Al

> ATRCKEAA MBI b, T A A B A

> ¥ Flash 4 f93C1F SWF BEEIEA, IFRHLEEAIEEHIZGE. BT Flash H4F
V2 &AM A, REG]CIBEE e S4l, i HFEmEnAD, SERRED T
Director?7.02 {4 HLEE LRI KA |

> AJLARAB)A GIF Ui o e F L JF BT il e R

> 37FF QuickTime 4, LA HOHLSIAT LA4K4E/E QuickTime 4 H# A, JHHR0EF & A4

HIThEE. :
> ATLLFBES N MP3 KU 8 S0, SRR RS 78 1 78 8 SO 0 R -
. > A[LASEREAI B PowerPoint SCAFAE Rt B AR, AU SCA R v
WEH LT —A Score IR A PR AER S BREAT )y IS Z) FRR . Fﬁf"&&?ﬁﬂlﬁ'ﬁl[mﬁ“ﬁfu
¥ PowerPoint U444 Jj Director H15¢.
> 485 Lingo WEHMAELMIR T, AUEHFFELL JavaScript 155775, iy FL3
AR AR mPRA], {EgiEEPEAS . R T Save As Java frd, XFEER
R Java B PEAARYSRC T . FH M a] AT G i L A7 ak Java JRACHD, B Cdmi AR % .
» BT —4 Library TR, IS T Director 1] Behavior FifFfiish, fn]
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PAIgE ik XA 1 HCE 82 4 K R 38 0 behaviors .

> EMINT A Vector Shape %1, fessfDGEICEREIE. KEEREAA ], q
AT S AE L, ifi FL AT DS SO LT P 0 1R 52 4 1 < AR .

- A[LUHDME TR, AR SR 5Erh R .

1.6 Director FE PRI TR

Director {4 YL 74 —A TR, Hoeh A o] ISEBE Director o i — e
HIEAE, ik 1-7 Ao,

EH1-7 TH%

Tl XA TR &P %

1. ﬁNew Movie $% il

pdXAMEHEL, e R R
2. E New Cast $%4l

BTG, e —ANET RO R .
3. ﬂ Open $#%41l

RiiXA e, BT g,

4. H Import %411

AT ANMEE, 4T IT Import XHEHE.

G Save 1%l
p XM, R,

Save All $%41
iXAMEHEL, B RFRE DT A,

7. W Save As Shockwave Movie {4
RATEANEH, W IE BT A Shockwave 3 LY .

8. 281 Undo &4
AR, R bR,

9. HCut %8
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FUEAMEHL, FITUET IR 2.

0. B3 Copy 1441
FXA G, K RHRES RN A

11, BB paste jxm
T IXANMEEL, BRI BTIE B e 2

Find Cast Member 741
X NMEHEL, ¥47FF Find Cast Member %} 5 HE .

Exchange Cast Member 441
RTIXANMEHL,  H U A B 11 bRk SO I A3 57 .

14. ZZ 4 Rewind $%41
RATX MG, BIERR LTI 1.

15. . Stop %41
RATIX N, F L g .

| Play %4
REIXANMEEL, KRB .

17. nStage el
RATIXANMEH, $ERES.

Cast Window %4
RdTXANMEH, KBERERE.

19. Score Window %41l
RiiX MG, BERBARGD.

20. Sprite Inspector %41
RATIXAN %4, ¥ 8o Sprite Inspector.

21. Library Palette $%41
RAdvX AL, # 875 Library T 24K

22:
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RN, Bz EEr .

23. @ Vector Shape {%l
palIXANGHEL, B B KR IEARE .

24. Text Window {%4H
MRIXAZEL, B RN A .,

25.
miFIXANE4L, ¥ 575 Behavior Inspector.

Behavior Inspector §#%

26. E Script Window $% 411
RdriXMEHL, ¥ B Seript B .

27 Message Window {441
miliEAN AL, BN Message & H .
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¥28 HHEREAIRES

HIVE R 2 BT T B T Sl ORI Director [IHRAE L AR/ FRBE .
2.1 & & General Preferences J1H#E

Director B # 1F 5 M 7 % i T General Preferences Xf if #E 3k ¥ &, & #
File>Preferences=> General 4% Cul+U §t, sfiv] LAFT HF General Preferences XJ#EHE, Wi
2-1 fi7ss

B 2-1 General Preferences A 15 4E
A X AN K TR HE D & A R g

1. Stage
XHEA 4 ANET, GTEANEDIR T —A IR, HPRITE G ERARS, B0
{7 B LA R s 4T 75 3

»  Use Movie Settings: & X —3, #f] IFIEFEHIEES T 11 Movie Properties X}
EHEF A8 B Hi5E . Movie Properties X if HEF 15 B il WG IR EE Y .

»  Match Current Movie: #EiX—0, T T A EHEE S T A Director 1 F—
WIT IR SRR & R —3

» Centered: HEFIX—I0, PEGMESETER,

>  Animate in Background: & IX—I, HHEMEATE)T 6, LRIzt &8k 80E1T.

EE

il % 2% ¥ Animate in Background 1, €& &M K F6)A 4.

2. User Interface
XA 4 NI, Mk T A EHE, HIKIfiE Director i H # M.
» Dialogs Appear at Mouse Position: M iX—I0, #TFF A% TEHERS HILAE BUBRATT




F2w  HEERRATORER 11

FIRTE : 7 TSR NG IR A B R 1wl

>  Save Window Positions On Exit: X —7, 7EiRH Director IO RA7 PR H T
6 ORI E, SXEEF — 3T FF Director it LI 7 1 RN SC A2 BT A 112 — .

>  Message Window Recompiles Scripts: i%£H11iX—Til, 4 #7E Message & 174 Enter
S}, Director ¥ R AIT LT A . Message B [LRIBA R P 20 LS A FEYS .

>  Show Tooltips: %ix—I, EbrEzNE| Director " T RMEILH s
MEFEMNUE —kbl, AEPUHAHE -TAIESE.

3. Text Units

XRRE—AN TR, R iR A A8 R A

>  Inches: ¥ErhiX—mi, eIV LIEh BT,

»  Centimeters: ¥ErIX—T0, HigLHF LUEK A 4T,

> Pixels: #HiX—I0, HEETTHRFLME RN PAL.

2.2 &8 Network Preferences X1 1H1E

F] Director HI¥E H i 1T LA 4% rh SR IUCEOR,  ifo FLAIVE A U SE b o] LAFE RS rh R AT
PR B R i 46 [ — e AT R E X MR LAES Network Preferences X
I HESRBETT -

P fFi%4E File> Preferences>Network. i 1] LAfTJF Network Preferences Xfi&HE, 1P
2-2 Fi7so

[ 2-2 Network Preferences 3 i HE
T A 8 AN SHEHED 55040 1 Al ik .

1. Preferred Browser

i3 HLR— AN HE, ] S Lo fAg . Director HHER LA 2% . 1 AL FF File-> Preview
in Browser I 343 F i FEL s g ] UL 288 ok P FL 5

2. Browse 1%l

S XA, T IT R EFTRR Select Browser X HHE, EIX AN i HEH BT LLEE
BRI D R ZE A RO
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W €

TAZNE F)

P 2-3  Select Browser %}iGHE

3. Options

IEPIX T, 75 A U 28 P R s 4T TR0 s .

4. Disk Cache Size :

XRR—ANAKRE, F I 2 W 4 0 78 Internet w48 F 3008 BT (3 B8 (0 i i 2 A7 (1 A/

5. Clear 1%

PTG, S B A A b G T A M

6. Check Document

IXPATNAIEI, M T AU, F AR i A B A TP R A IR 45 28 h Al
FEgR ). SEBR EARSS A SR S H TR, BTLAX BA B E R IR L E.

»  Once Per Session: MEHIX—I0, BERMEEFT T3 A Director B2 Lo — B .

»  Every Time: EPX—T0, #4847 IFHM— it Lbss— ¥l . — BB,
BAIEPIX T,

7. Proxies

XA AR, MR T —H kL, AR R R 544

»  No Proxies: %X —I0, J§ Al FHACFEAR 55 8%, IX R WA (1) 1 5L 1L B B Internet
% .

»  Manual Configuration: EHPIX T, & EMCHAR % St v & .

8. http A1 ftp

X R RANANE, ADRBCEACHAR 5588, B EE MM URL fis 02,

2.3 % & Movie Properties ¥1EHE

XHBFRNATRGIME. £—mEdh, LMD HES. Fifm
M EAE X BN GE G . KB RENLLE, WANNABERL 4SS kA
fEfFLASERY.

[FI¥f, {F Dircetor7.02 1, Stage($F ) MPHEE R UA A B . FrE BT AR A 45
LENEX G E K. %P Windows>Stage 4% Culel &, MTLITIFES, mE
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2-4 7.

K24 #fG

Director 7 [ 3F 5 A2 v] LLEFEHEAN M 5G], 1X A4 Director7.0 BART P RRCAS H 42 il A~ 3
f. ABREAN LR SRS I A, X — ) Windows % M1 X A
Director FFEG R —A _gE=d(a], X S PRBEG EAFM . JSFF g wf Ui — 5
AT =4 fshm SR, B AR R T AWM . ALk, Director tH H A7
7E X Ak Y AbkR, WAT Z kb, ANt Director T LA Z FSCrE, bk S el
TEUFIR =R M, X 0] BUBEAE — 5] o5 () () #b 780

Movie Properties %} 15 HEH i3 B L2 AT 28 048 14, £ Modify->Movie-> Properties
504% Curl+Shift+D 8, 8 o] UTHFX A i6HE, Wil 2-5 fros.

ztem - Win

I8 2-5 Movie Properties 4 i #{E
i EHX A HEHE 50 ik
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1. Stage Size
XL —AN R, FR BRI A A ST @t nT LU LA 75 1) Width %5 AHERD Height

0 NAE KA NS G5 B9 56 FSE R0 5 E

2. Stage Locating

XHR—ANThER, RRNEFEIIALE.

»  Centered JEHIX—I0, PECFE R,

>  UpperLeft: i&rfux—11, P& L EaR.

»  Other: HEFPIX—I0, SRR A 77 A AME A AR bR i s FUAL & . X LR
SAESRI T T A EA .

FE:

XEHE(E X ERRRRA S A Director PHATIEGEE, —EaFAEHT

PATIAHEATH, XERENFCALERILRIEAT,

3. Stage Color

KPR G i, SRE LG R G AT I R G BORIE R, e B
LEATTT (4R AHE P 4 N RGB RO EPRSI, U0 (¥3E PP 15 WS thI A 5E Y

4. Color Selection

XA, HIRT —2 i l, FIRm e v i b a8 H e .

» RGB: #EHPIX—I, K4 RGB (ki .

>  Palette Index: XEHVIX-—T00, FF MU /6 T (B rp 4k B R A SIS . X —T50A
b I AR A WG .

5. Default Palette

X R AR R, R e s b B U (. R By 4 R I D i A B

6. Options

IXPAHPAEI, Ak T — AN SEHE.

»  Remap Palettes When Needed: A IX— 0, 85 A~ T V8 A 058 b3 1L BRTE B
2 ki, Director FFACRE B, SURL 3 FHBR DA (AR b B S ALL AR €0 ARV A P OB R

»  Maintain Outdated Ink Mode Limitations: i#r1X—J0, B¢ O0REBURHSE X r) PR 1 .

7. Score Channels

X ANMANE, Fkfe e s A i & SO WS A EY,  Director
AR BRIA R B A S B0 120 4, S NIHE HOE 1000 4, HE 7.0 LARTIIRCASAS T8RRI,
AXFE LY AT AR i =5 282

T

RE A AL EANAER 2 9999, {224 EHKT OK #&45, A&l 1000 &)

i NALARSR B 3 K A%, 1000,

2.4 & & Grid Settings 3 1EHE

PEE IR — N A I T I, MRUAL Grids(BiHe), X nT LAHIKRAT T8 6 ERIRER .




